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Srednja Skola Koprivnica Upute za izradbu zavrsnoq rada

1. ZAVRSNIRAD

Zavrsni rad je uCenikova samostalna struna obrada izabrane teme. Izradbom i obranom zavr$nog rada
ucenik:
e pokazuje stupanj usvojenosti teorijskog i prakticnog znanja i sposobnost sluzenja struénom
literaturom i elektronikim izvorima podataka,
o dokazuje stupanj ste¢enih kompetencija i ishoda obrazovanja u obrazovnom profilu,
e pokazuje se kompetentnost samostalnog istrazivanja i struéne obrade izabrane teme na
sustavan, smislen i gramaticki i pravopisno ispravan nacin.
Obranom zavrSnog rada u obliku prezentacije pokazuje se ucenikova sposobnost samostalnog
izlaganja, objaSnjavanja i prezentiranja rezultata istrazivanja u pisanom radu.

UCenik izabire temu zavrdnog rada u dogovoru s predmetnim nastavnicima struke, a postujuci rokove iz
Pravilnika o izradbi i obrani zavr$nog rada.’

Nakon izbora teme zavrSnog rada ucenik predlaze nacrt ili strukturu zavrSnog rada mentoru na
redovitim konzultacijama. Ovdje je vazno da uCenik navede popis literature i druge izvore podataka
koje namjerava koristiti pri izradi zavrSnog rada. Nastavnik zajedno s u¢enikom definira precizan sadrza;
I strukturu zavrSnog rada. Tijekom izrade u vrijeme dogovorenih konzultacija nastavnik stoji na
raspolaganju za sve eventualne nejasnoce, sugestije oko pisanja rada i savjete oko dodatnih izvora
literature. Nakon Sto izabere temu zavrSnog rada uCenik prikuplja literaturu, udzbenike, Clanke iz
¢asopisa, informacije s interneta ili baza podataka koji obraduju izabranu tematiku. Prou¢avanje struéne
literature je nuzan preduvjet daljnjeg samostalnog rada.

UCenik izraduje rad samostalno s pravom i obvezom redovitih konzultacija s mentorom. Mentor prati rad
ucenika i pomaze mu savjetima, a moze zahtijevati doradu, izmjenu ili dopunu zavrsnog rada. Ucenik je
duzan postupiti prema uputama i primjedbama mentora.

Zavrs$ni rad treba spiralno uvezati u dva primjerka (jedan se predaje mentoru, drugi se urudzbira).

Zavrsni rad sastoji se od sliedecih dijelova:
1. Naslovna stranica

2. Sadrzaj

3. Sazetak

4. Uvodni dio

5. Glavni dio - razrada teme

6. Zakljucak

7. Literatura

8. Popis slika/grafickih prikazaltablica

9. Prilozi

10. Posljednja stranica rada (za upisivanje ocjena)

! Broj tema treba biti 50% veci od broja uenika (npr. ako imamo ukupno 30 maturanata u cijeloj $koli, treba ponuditi 45
tema).

Koprivnica, $§k.god.2017./2018.




Srednja Skola Koprivnica Upute za izradbu zavrsnoq rada

2. DIJELOVI ZAVRSNOG RADA

2.1.Naslovna stranica
Autor naslovnom stranicom uspostavlja prvi kontakt s Citateljem rada i ostavlja prvi dojam o zavrSnom
radu. Naslovna stranica treba sadrzavati osnovne podatke: o S$koli, smjeru, uceniku, mentoru,
nastavnom predmetu, temi zavr$nog rada (naziv teme), $kolskoj godini, te biti oblikovana prema
pravilima i uputama struke. Naslovna stranica se ne oznacCava rednim brojem, a ubacivanje slikovnih
prikaza se ne dozvoljava. Primjer oblikovanja naslovne stranice zavrSnog rada nalazi se u prilogu uputa
(Prilog_1., str.12.).

2.2.Sadrzaj
Sadrzaj predstavlja tematski prikaz rada i daje uvid u stranice rada na kojima se nalaze naslovi cjelina,
poglavlja, odjeljaka. Sadrzaj se stavlja odmah iza naslovne stranice rada te ga je potrebno oblikovati
prema pravilima i uputama. Primjer oblikovanja stranice sadrzaja nalazi se u prilogu uputa (Prilog_2.,
str.13.), a objasnjenje oblikovanja i umetanja sadrZzaja dano je u nastavku uputa (3. Oblikovanje
zavr$nog rada).

2.3.Sazetak

Sazetak je, kako mu i ime govori, sazeta verzija cjelokupnog rada. PoZeljan opseg sazetka je jedna do
jedna i pol stranica teksta. Sazetak se moze poceti pisati tek kada je cjelokupan zavrsni rad napisan,
toCnije: dio rada od uvoda do zakljucka. PiSe se bez podnaslova, poput eseja (ne numerira se kao
cjelina, ve¢ se samo stavlja naznaka, naslov da je rije¢ o sazetku), a u njemu se ukratko:

= opisuju svrha i ciljevi rada,

» jzlazu teorijska polazista,

= povezuju s prakticnim dijelom,

» navode zakljucci.
Stranica saZetka se numerira (primjerice: rimskim brojevima).

2.4.Uvod
Uvod sadrZi osnovne naznake problema koji se razmatra: imenuje se problem i razlog izbora za
predmet prouc¢avanja, nacin obrade problema i strukturu rada. Uvod se numerira arapskim brojem 1
(predstavlja prvu cjelinu rada), kao i broj stranice rada koji se oznacava arapskim brojem 1. Objasnjenje
oblikovanja i umetanja brojeva stranica dano je u nastavku uputa (3. Oblikovanje zavr$nog rada).

2.5.Glavni dio
Glavni dio ili razrada teme zavrSnog rada, ukoliko to tema dopusta, sastoji se od dva temeljna dijela.
Prvi dio odnosi se na teorijski dio obrade teme u kojem se navode teorijski doprinosi razli€itih autora i
objadnjenje iste, dok je drugi dio prakticni dio u kojem se prikazuje konkretan primjer problema ili slu¢aj
iz prakse. Cjelokupan sadrzaj teksta u radu treba biti smisleno rasporeden. Cjeline rada se oznacavaju
arapskim brojevima, kao i brojevi stranice zavrsnog rada.

2.6.Zakljucak
Obrada teme zavrSnog rada zavrSava cjelinom zakljuéak u kojemu je potrebno ukratko prikazati
rezultate i spoznaje do kojih se doSlo prilikom obrade teme zavrSnog rada. Ujedno, u zakljucku je
pozeljno iznijeti stav o istrazenom problemu, prikazati eventualnu nepodudarnosti teorije i prakse, te

Koprivnica, $§k.god.2017./2018.




Srednja Skola Koprivnica Upute za izradbu zavrsnoq rada

istaknuti vlastita misljenja i prijedloge. Zakljuak mora zapoceti na zasebnoj stranici, numerira se kao
cjelina i brojevi stranice se nastavljaju u odnosu na glavni dio.

2.7.Literatura

Popis literature koja se koristila prilikom obrade teme zavrSnog rada slijedi nakon zakljucka, a prije
popisa slikovnih, grafi¢kih ili tabelarnih prikaza te eventualnih priloga ili dodataka. Naslov Literatura
numerira se i piSe velikim slovima na vrhu stranice. Primjer oblikovanja literature zavrSnog rada nalazi
se u prilogu uputa (Prilog_3., str.15.). lzvori se nizu abecednim redom prema prezimenu autora, a
ukoliko ne postoji autor ili urednik izvora, zapisuju se prema prvoj rijeci iz naslova. lzvore numeriramo sa
arapskim brojevima, navodeci najprije prezime autora koje se odvaja zarezom od inicijala imena. Zatim
se piSe naslov knjige, ime izdavacke kuce, sjediste izdavacke kuce ili mjesto gdje je knjiga izdana te
godina kada je izdana. Clanci koristeni u radu navode se na slijedeci nagin: najprije se zapisuje naziv
autora, zatim naslov Clanka te Casopis u kojem je Clanak objavljen, broj ¢asopisa, godina izdanja
navedenoga broja, te stranice na kojima je Clanak tiskan. Objasnjenje oblikovanja i oznacavanja
literature dano je u nastavku uputa (3. Oblikovanje zavr$nog rada).

2.8.Slikovni, graficki i tabelarni prikazi

Nakon popisa literature, na zasebnoj stranici navode se slikovni, graficki ili tabelarni prikazi koji se
nalaze u cjelinama zavr$nog rada. Naslov Slikovni prikaz, Grafi¢ki prikaz ili Tabelarni prikaz numerira se
i piSe velikim slovima na vrhu stranice. Ukoliko se u radu nalazi manji broj i slikovnih i grafikih i
tabelarnih prikaza, mozete ih staviti na jednu stranicu, tako da odvojite dvostrukim proredom naslove.
Popis navedenih prikaza numerira se arapskim brojevima, stavlja se oznaka slike, tablice, grafickog
prikaza, broj slike, tablice ili grafickog prikaza, naziv prethodno navedenog i broj stranice na kojoj se
nalazi. Ujedno, popis slikovnih, grafickih i tabelarnih prikaza potrebno je navesti i u sadrzaju rada.
Primjer oblikovanja popisa slikovnih, grafi¢kih i tabelarnih prikaza zavr$nog rada nalazi se u prilogu
uputa (Prilog_4., str.16.). ObjaSnjenje oblikovanja i oznaCavanja dano je u nastavku uputa (3.
Oblikovanje zavrSnog rada).

2.9.Prilozi
Prilozi (dokumenti i sli¢no ) koje ste koristili prilikom obrade teme zavr$nog rada, a koji dopunjuju
zavr$ni rad, stavljaju se na kraj rada. Numeriraju se na vrhu stranice (Prilog br. 1, Prilog br.2 ...), svaki
prilog ima svoju stranicu i kao takvi se navode u i sadrZaju rada.

2.10. Posljednja stranica rada
Na posliednjoj stranici rada ostavlja se prostor u koji Ce se upisati datum predaje rada, ocjena izradbe
rada, potpis mentora kao dokaz da je mentor prihvatio rad, datum obrane rada i ocjena obrane rada, te
zavr$na ocjena koja proizlazi iz aritmetiCke sredine ocjena izradbe i obrane rada. Moguce je upisati i
komentar mentora ili komisije za obranu. Primjer oblikovanja posljednje stranice zavrnog rada nalazi se
u prilogu uputa (Prilog_5., str.17.).

2.11. Konzultacijski list
Mentor za svakog uéenika ispunjava konzultacijski list na kojem evidentira kada je i koliko puta u¢enik
bio na konzultacijama. Konzultacijski list ostaje kod mentora i nije dio zavrénog rada. Primjer oblikovanja
konzultacijskog lista nalazi se u prilogu uputa (Prilog_6., str. 18.).
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3. OBLIKOVANJE ZAVRSNOG RADA

3.1.Podsjetnik
Prije pisanja zavrSnog rada treba se prisjetiti:

v' rijei se odvajaju samo jednim razmakom,

v"interpunkcijski znakovi (., ? ! : ;) piSu se zajedno s rijeéju iza koje slijede, a nakon navedenog
ostavlja se obvezno jedan razmak,

navodnici i zagrade piSu se zajedno s rijeCju ispred i iza koje se nalaze,

crtica se piSe zajedno s rijeCima izmedu kojih stoji ako se radi o slozenici

(npr. matematicko-informaticki), a odvojeno ako se koristi u neku drugu svrhu,

re¢enicu nikada ne valja zapocinjati brojkom,

tekst treba pisati u odlomcima (odlomak je dio teksta koji zaklju€ujemo tipkom <Enter> ),
pocetak odlomka mora biti uvu¢en > tipka <Tab>,

ukoliko navodite ili numerirate dijelove teksta u razradi sadrzaja iza navedeno stavljate zarez, a
iza posljednjeg navoda tocku (kao $to je oznace i navedeni navod) .

ANERN

ANENENEN

3.2. Razrada sadrzaja zavr$nog rada

3.21. \Velicina slova i vrsta pisma
Standardna veliina slova za cijeli tekst u razradi sadrzaja je 12, dok su naslovi cjelina 14. lzuzetak je
naslovnica gdje je dio pisan fontom 14, a dio fontom 12 (vidi Prilog_1).
Vrsta pisma (font) treba biti Times New Roman ili Arial, a odabrani font mora se primjenjivati na cijeli
tekst zavrSnog rada. Stil fonta (Bold, Italic, Underline, promjena boje slova), odnosno nacin isticanja
dijelova teksta se ne primjenjuje na cijeli tekst, ve¢ samo na pojedine rijeci ili dijelove recenica koje se
Zele posebno istaknuti. Navedeno, nije pozeljno koristiti preCesto, buduci da ¢e rad izgledati neuredno,
a isto tako potrebno je voditi raCuna da je preporuka koristiti najviSe tri razli¢ita oblika isticanja dijelova
teksta jer ¢e u protivnome rad izgledati kao slikovni prikaz. Veli€ina slova i nacin isticanja mijenjaju se
na slijedeci nacin:

a) OznacCi/odaberi sve (Edit > Select All),

b) veli¢ina slova je 12 (Format = Font - Size: 12)

c) font (Format > Font - Font: Arial/TNR)

3.2.2. Obostrano poravnanje sadrzaja

SadrZaj rada potrebno je (obavezno!) poravnati obostrano (naslove ¢emo naknadno oblikovati),
ostavljajuci prored izmedu redova 1,5 (standardni prored za zavr$ni rad):

A) oznaci sve (Edit = Select All)

Izgled stranice  Reference  Skupnapisma  Pregled  Prikaz

Arial Narrow b LRI P (2 ET| saBsces aaBbCa AaBhC

B I U -abex X Aa-|[- A- Istaknuto ~ Maglaena Naslov

Font

Odlomak

. L e Vrsta pisma (fcné) ;r;abra Rory mrfont mora se pri

Paragraph = Alignment: justified) tokt zavrinag ada. S| pisc ey
dijelova teksta se ne pri ine rijedi ili dijelov

Zele posebno istaknuti- , buduéi da ée rad i

jevom i desnom
rebi dodajuéi dodatni

B) poravnanie je obostrano (Format > I KRR TR 1 t

a isto tako potrebno je voditi ratuna da je preporuka koristiti najviSe tri razlicita oblik:
teksta jer ¢e u protivnome rad izgledati kao slikovni prikaz. Veliéina slova i nagin isti
na slijedeci nacin:
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Skupna pisma Pregled Prikaz
SN E SR e e A AaBbCcl AaBbCd AaB
-2 - A ||| = =||4=-|| & - o) ||| staknuto  Naglageno Nasle
IE] Odlol 10
-|O-13|-z-|-)-|-4‘| 115 |11t 11201
C d . 1 5 F t 9 P h 9 L' 321, Veligina slovaivrst] V| °
) prore Je . ( orma aragrap ine Standardna veligina slova zal 20 dok su naslovi
. . . ) S 25
SpaCIng 1 5 ||neS) naslovnica gdje je dio plEa.ﬂf J.}.
Vista pisma (font) treba biti 30 ani font mora se
tekst zavrdnog rada. Stil fon Moguénosti proreda... boje slova), od
dijelova teksta se ne primjen| £ Dodaj razmak ispred odlomka  2dine rijedi ili dije
Zele posebno istaknuti. Nave 55 podaj razmak naken odlomka buduci da ce n

a isto tako potrebno je voditi racuna da je preporuka Konstiii navise tri razli¢ita ol
teksta jer e u protivnome rad izgledati kao slikovni prikaz. Veliéina slova i nagin
na slijededi nacin:

3.2.3. Postavljanje standardne margine stranica
Standardne margine stranica (gore, dolje, lijevo i [
desno) su 2,54 cm (1 inch). Potrebno je postauviti
i uveznu marginu slijeva (oko 1 cm) koja sluzi s
uvlacenje odlomka.

File - Page Setup... = Kkartica Margins >
margine (Top, Bottom, Left, Right) staviti na 2,54
cm, a uveznu (Gutter) na 1 cm

Uredu Odustant

Arial Narrow o PR 1 (=R SRt

EUIT gagboel AaBbC

A= de i3 ]| staknuto  Naglstend cli

[B I U-aex x Ar|¥ A
Fort i Odonak v kliknuti na ravnalo na 1,5, pojavi se mali crni znak u
cri i e s e w i otk slova L i svaki puta kada se klikne na TAB

Standardre marging stranica (gors, dolfe, ligvo i desno) su 254 em ( t tski . drzai tavli kolik

uveznu marginu slieva (ko 1 cm) koja suzi s wiatenje odlomka. automaiskl uvuce sadrzaj na postavijeno (U OliKo ga

File 3 Page Setup.. < kaica Margirs  margie (Top, Botom, L« Zelite ukloniti, kliknuti na navedeno, drzati i maknuti s

e @%:””” i ravnala te pustiti).
Kiknuti ia ravnalo ma 1,5, pojavi Se maii cmi znak u obiku slova Li sy
automatski uvuce sadrzaj na postavlienc (ukolike ga Zeiite uklonit, Kikn,

5 raunala fe pusiti).

3.2.4. Slikovni, graficki i tabelarni prikaz

Slike, crtezi, tablice i grafikoni ubacuju se izmedu teksta te nadopunjuju i potvrduju navedenu razradu
sadrZaja. Po jedan red razmaka stavlja se prije i poslije prikaza. Svaka slika, crtez, tablica ili graficki
prikaz ima slijedece oznake:

Naznaku o ¢emu je rijeC: slika, graficki prikaz ili tablica,
Redni broj,

Naziv,

Prikaz — slika, tablica, graf,

lzvor,

o wd -

a navedeno se piSe uskoredno, jedno ispod drugog, bez rednog razmaka (prored je 1,0).
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Navedeno je u razradi sadrZaja teme moguce oblikovati na nekoliko nacina:

1. centriranjem na sredini stranice, ili
2.0d 0. TAB-a (bez uvlaCenja).

Ujedno, oznake je moguce pisati na slijedeci nacin:

1. oznaka, redni broj i naslov iznad prikaza, a izvor navedenog ispod prikaza, ili
2. oznaka, redni broj i naslov ispod prikaza, a izvor navedenog se stavlja kao fusnota.

Primjer tablicnog prikaza, pisanje od 0.TAB-a:
Tablica 2. Nova retorika

Nema hijerarhije, sugovomici su ravnopravni, poruke se
JEDNAKOST prenose i primaju tijekom rasprave.

Ljudi su slobodna bica i ocekuje se da se ponasaju

razlicito, sukladno kulturi iz koje potjecu, odnosno
POZNAIE SE

RAZLICITOST L I kulturnom prostoru u kojem se ostvaruje komunikacija.

Ponajprije se usmjeruje na prihvacanje konsenzusa,
KOMUNIKACIIA odnosno suglasnosti.

Izvor: autor prema Sikavica, P, Bahtj arevi¢-Siber, F., Pologki Vokic, N.: Temelji menadzmenta, Skolska
knjiga, Zagreb, 2008, str.28

Primjer slikovnog prikaza, centriranjem na sredini stranice:

Slika1. Priprema prodavaca

Izvor: https:/iwww

3.2.5. Umetanje brojeva stranica

Stranice zavrSnog rada trebaju biti
pravilno oznacene. Broj stranice mozete
umetnuti ili u zaglavlje (header) ili
podnoZje (footer). Takoder, moZete
odabrati izgleda broja stranice, boju, font.

a) Insert > Page Numbers
b) mozemo odabrati hoce Ii brojevi e s

stranica biti gore ili dolje (Position)

Iy
c) lijevo, desno ili u sredini (Alignment) % A

d) naslovna stranica bez oznake broja
stranice  (ostaviti prazno Show

number on first page)

| ==
Naslovna siranica. sadzZ3) | sazetak ne smie ima oznaiu arapskiog broja stranice: [
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Naslovna stranica, sadrzaj i sazetak ne smije imati oznaku arapskog broja stranice. Najbolji nacin za to

je umetanie prekida stranice. Primjer:

mo tni | Dgledstranice ~ RefeNnce  Skupnapisma  Pregled  Prikaz
== =] £
B = Prekidi N[ N || uviaka
Prijelomi stranice vo: |0

Margine Orijentacija Velicina Stupci

ekt Stranica lena: (0
e 5| ?arnlf.j;?::\|njenﬂ kojem jedna stranica zavriava
i3 R
] Stupac i \pka <
Oznadi da ée tekst koji slijedi prijelom stupca
=| poceti u sliedecem stupcu. tekstal
€ 0Zna
Prelamanje teksta
=, Razdvoji tekst oko objekata na web stranicama,
kao ita je opis teksta iz tijela teksta.
ada
Prijelomi odjeljka
Sliedeca stranica
[S Umetni prijelom odjeljka i zapoéni novi odjeljak
— ljedecoj st 3
= na sljedecoj stranici. odi sa
Neprekinuto infom 1
s=—| Umetni prijelom odjeljka i zapoéni novi odjeljak fan jli A
= na istoj stranici.
= Inderlin|
= Pana stranica | vet 4
Umetni prijelom odjeljka i zapoéni novi odjeljak | ) 1
':ﬁ na slijedecoj pamoj stranici,
—— oruka
i Neparna stranica kovni
Umetni prijelom odjeljka i zapocni novi odjeljak
Py nasliedecoj neparo steanic
bl ualifina claun ia 17 (Eamat 2 Cont 3 Qiza

Prekid stranice — prijelaz na slijede¢u stranicu, stupac ili
prelamanje teksta.

Odjeljak = sekcija

Prijelom odjelika — stvaranje zasebnih cjelina u
tekstualnom dokumentu.

Prijelom stranice - postavljanje kursora na pocetak
slijedece stranice.

Prazna stranica — umetanje prazne stranice u tekstualni
dokument.

Ukoliko koristimo prijelom stranice tada je
moguce promijeniti zaglavlje i podnoZje, a da
se ono ne nadovezuje na prethodno
napisano u zaglavlju i podnozju, pa i
promijeniti brojeve stranica (numeriranje).

Kada otvorite zaglavlje ili podnozje i ne Zelite
da se ono nadovezuje na prethodnu sekciju
kliknuti na povezi s prethodnim, tada moZete
promijeniti zaglavlje ili podnozje bez da se
prethodno promijeni, pa i umetnuti brojeve
stranica, a da se one ne pojavijuju na
naslovnoj stranici, sadrzaju ili sazetku.

T—

[zgled stranice Reference Skupna pisma Pregled Prikaz Dizajn

- E (5 Prethodna sekcija Razlicita prva stran
L J‘I i

b5 |oal B ; o .
j Slijedeca sekcija Razlicite neparne i

umi Brzi  Slika Isjedak || Id Idina e - - L
:me dijelovi~ crteia | zaglavlje podnodje ‘%‘;Pmrensprethodmm ‘ V| PrikaZi tekst dokun
Umetni MNavigacija Moguéno
"2"'1"'5"'1"'2 Povedi s prethodnim ' F

Povezite s prethodnom sekcijom tako da
zaglavlje i podnozje u trenutnaj sekciji
imaju isti sadrZaj kao i prethodna
sekdija.

- &) Za dodatnu pomoc pritisnite F1.

a) Maslovnom stranicom
sadrZzavati osnovne pt
predmetu, naslowvu

oli, smjeru

Podnozje Sekdja 1- pditi 43 tema).

autor uspostavlja pr

! Broj tema treba biti 50% veci od broja uéenika (npr,ako imamd

3.2.6. Zaglavlje i podnozje

U zaglavlje ili podnozje moze se smjestiti tekst koji ¢e biti vidljiv na svim stranicama rada. Primjerice, u
zaglavlie moZete napisati naziv autora i naslov rada $to je zgodno podvuéi da se odvoji od glavnog

teksta.

a) View - Header and Footer,

b) otvorit ¢e se okviri za zaglavlje i podnozje (ostatak teksta je sive boje),
C

d

i podnoZje sive boje),
€)

)
) upiSemo Zeljeni tekst, formatiramo ga — veli€ina slova, poravnanije, crta ispod,...,
) naredbom Close zatvaramo pogled zaglavlja i podnoZja i vratamo se u tekst rada (sad je zaglavlje

Print Preview (pod File) moZzemo pogledati jesmo li zadovoljni izgledom rada.

3.2.7. Oznacavanje dijelova (cjelina) zavrSnog rada
Najpreglednije naCin oznacavanja dijelova rada predstavlja decimalni sustav brojeva. Svaka se glava

(cielina) oznaCava arapskim brojem (1., 2., 3.

,...). Prva znamenka svakoga poglavlja podudara se s

brojem glave kojoj poglavlje pripada, a druga znamenka oznacava redni broj navedenoga poglavlja

Koprivnica,
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(1.1.,1.2,, 1.3.,...). Isti postupak slijedi za oznaCavanje odjeljaka (1.4.1., 1.4.2.,...) i to€aka. (Pogledati
kako je rad oznacen u sadrZaju, Prilog br. 2).
Najprije se treba "proSetati" tekstom i ispred naslova dodati gore navedene oznake. Pritom se i prije i
poslije naslova stavlja po jedan red razmaka. Svaka glava (cjelina) treba poceti na novoj stranici (Insert
-> Break - Page Break). Zatim se naslovima dodjeljuju stilovi:

o Naslove cjelina formatira se u Naslov1 (Heading1),

e nazive poglavlja u Naslov2 (Heading2),

e nazive odjeljaka u Naslov3 (Heading3),
pritome se svakom stilu (Heading1, Heading2, Heading3) moZe dodati joS neki od formata za
oblikovanje teksta kao npr: Bold, ltalic, Underline. VeliCina slova za Heading! mora biti ve¢a od
Heading2, a ona veca od Heading3 koja je veca ili jednaka normalnom tekstu ( font 12). Oznaci se prvi
naslov cjeline, na njega se primijeni Heading1 (Format > Style > Heading1...), po zelji se doda jo$
neki od formata za oblikovanje teksta (boja, veli€ina slova). Nakon toga se u popisu stilova javlja
Heading1+... (ono Sto ste dodali). Zatim se redom oznacavaju i naslovi preostalih cjelina i na njih se
primijeni isti taj stil Heading1+... Zgodno je za to koristiti prenositelja oblikovana (Format painter). Isti
postupak se ponavlja za poglavlja (Heading2+...), odjeljke (Heading3+...),...

3.2.8. Citiranje i biljeSke
Prilikom citiranja autora u razradi sadrzaja, citat je potrebno staviti u navodnike, primijeniti kurziv (stil
Italic) te navesti autora kojeg smo citirali. Za to se mogu koristiti fusnote u koje se mogu stavljati i
definicije, napomene i sli¢no. Primjerice: "Informacijska znanost je znanost koja se bavi informacijama u
najSirem smislu." 1 . Fusnote umeéemo na slijedeéi nacin:

a) Insert > Reference = Fusnote = OK, u tekstu se pojavio se redni broj fusnote (1),

b) na toj stranici ispod teksta iza znaka ' potrebno je dopisati komentar na citat ovako:

1 Grundler, D., Blagojevi¢, L. Informatika 1, Zagreb: Skolska knjiga, 2007., str. 14.

Fusnote za materijal preuzet s Internet stranice (€lanci) ili izvor slikovnog prikaza - potrebno je staviti dio
linka i datum.

3.2.9. Navodenje literature

Navodenija literature ovisi o tome je li rije€ o stru¢nim knjigama, stru¢nim ¢lancima ili Internet stranicama
koje se koriste prilikom razrade sadrzaja zavrSnog rada. UdZbenici srednjoSkolskog obrazovnog sustava
ne mogu biti izvori literature!

Primjer navodenija literature:

1. Kuvaci¢, N: Poduzetnicki projekt — Kako saciniti biznis-plan?-Teorijski
prikaz, Veleudiliste u Splitu, Split, 2001.

2. Marusi¢, M: Plan marketinga za uspje$no trZiSno poslovanje, Adeco,
Zagreb, 1998.

Strucne knjige:

1. Solomon, G., King, S: Issues in growing a family business, Journal of
Small Business Management, 2001. vol. 39(1), pp. 3-13.

Strucni clanci 2. Jelavi¢, F: Aktivnosti uCenika kao temeljna odrednica nastave, Pedagoski
rad, br. I, 1988., str. 44 — 51.
Internetske 1. web stranice Hrvatske gospodarske komore www.hgk.hr (10. 01. 2010)
Stranice: 2. www.Home-Small-Business.com (05.12. 2009)
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Osim cijelog imena Internet stranice u zagradi je potrebno navesti i datum posjete stranici s koje
smo preuzeli podatke!

U izradi svoga zavrSnog rada koristit Cete Internet pa je stoga vazno naglasiti da se metoda copy-paste
s interneta u Word ne smatra izradom zavrSnog rada. Podaci se mogu preuzeti s interneta, ali to na
smije biti copy-paste Citavih stranica.

Podsjetnik: Izvori se nizu abecednim redom prema prezimenu autora, a ukoliko ne postoji autor ili
urednik izvora, zapisuju se prema prvoj rijeci iz naslova. lzvore numeriramo sa arapskim brojevima,
navodecCi najprije prezime autora koje se odvaja zarezom od inicijala imena. Zatim se piSe naslov knjige,
ime izdavacke kuce, sjediSte izdavacke kuce ili mjesto gdje je knjiga izdana te godina kada je izdana.
Clanci koridteni u radu navode se na slijedeéi nacin: najprije se zapisuje naziv autora, zatim naslov
Clanka te Casopis u kojem je Clanak objavljen, broj Casopisa, godina izdanja navedenoga broja, te
stranice na kojima je Clanak tiskan.

Broj stranica zavrsnog rada: - za prodavace: od 7 do 10 stranica, a za ekonomiste i
komercijaliste od 10 do 15 stranica2.

Naslovna stranica i prilozi se ne raunaju!

Dva primjerka spiralno uvezanog rada (s potpisom mentora na posljednjoj stranici kojim se
potvrduje da je mentor prihvatio rad ) treba predati u tajniStvo Skole na ovjeru i urudzbiranje do
dogovorenog roka.

U dogovoru s mentorom (do navedenog datuma) predajete rad na prvo ¢itanje!

Do datuma koji vam kaze mentor rad se predaje u spiralnom uvezu u dva primjerka.

Cilj je izradbe i obrane zavr§noga rada provjera, vijednovanje i ocjenjivanje postignutih strukovnih,
odnosno umjetnickih kompetencija ucenika, steCenih obrazovanjem prema propisanim stru¢no-
teorijskim i prakticnim dijelovima nastavnih planova i programa, ¢ime Stjecu zavr$nost u upisanome

obrazovnom programu te uvjete za ukljucivanje na trziste rada.

Mentor nije duzan prihvatiti rad ukoliko on ne zadovoljava pravila oblikovanja i preporuke, bilo da je rije¢
0 oblikovanju sadrZaja ili razradi sadrzaja teme!

2 Jedna stranica teksta treba sadrzavati 1800 znakova po stranici,tj. jednu karticu teksta. Kako izraunati karticu teksta?
Tools (alati)--Word count (brojanje rije¢i)—Caracters with blank spaces (znakova s prazninama). Dobiveni broj podijelite s
1800 i dobit ¢e te to¢an broj napisanih kartica (koji treba biti jednak zadanom broju stranica).

Koprivnica, $§k.god.2017./2018.




Srednja Skola Koprivnica Upute za izradbu zavrsnoq rada

4. OBRANA ZAVRSNOG RADA

Obrana zavrnog rada:

>

Y

>

Koprivnica, $§k.god.2017./2018.

zavr$ni rad brani se pred tro€lanim povjerenstvom koji Cine razrednik, mentor i profesor struke,
obrana rada traje najduze 30 minuta,

od ucenika se ocekuje da samostalno predstavi osnovne teze svoga rada, da pokaze
samostalno vladanje obradenom temom i odgovori na pitanja ispitivaca,

samostalno predstavljanje teme rada obavlja se uz pomo¢ PowerPoint prezentacije koja mora
imati 10 slajdova (ukoliko to mentor trazi),

Ukoliko ucenici imaju noviju verziju Microsoft Officea neka prezentaciju pri snimanju pretvore u
verziju 97-2003. - Save as-Save asType: PowerPoint 97-2003.,

nakon prezentacije uCenik odgovara na pitanja povjerenstva,

uceniku se ocjena ne priop¢ava odmah, nego tek kada svi ucenici zavrSe s obranom radniji.
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Prilog br .1: Naslovna stranica zavrSnog rada
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Trg slobode 7

Zaglavlje;
|:> Centrirano

Font 14, Bold

Centrirano, Font 14,

48000 Koprivnica
*
Zavrs$ni rad iz predmeta: :> Centrirano, Font 12
*
Poduzetnistvo [ >
* Bold
Tema: :> Centrirano, Font 12
Obiteljsko poduzece kao oblik poduzetni¢kog pothvata
* \—Z‘> Centrirano, Font 14, Bold
*
*
*
*
*
*
*
*
* Font 12
Uvuceno na L
Mentor: 1.TAB Ucenik:
Ana Ani¢, prof. Poravnato :> Marko Mari¢, 4.a
ljevostrano Smjer: Komercijalist
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Prilog br. 2: Sadrzaj
SADRZAJ:

STV = 1 O I
L U LY | 5 PP 3
2. RACUNOVODSTVO TRGOVINSKIH PODUZECA ........cooeveeeeeeeeeeeee e 4
2.1. Pojam raCunoVvOodSiVa ...........oiiiiiiiiiicei e 4
2.2. Povijesni razvoj raCunovodStVa ...............uuueueuiiiiiiiiiiiiiiiiiiiiiiiiiiiiieeeeeeeees 4
2.3. Nacela raCunovodStVa ............uiiiiiiiiiiiii e 5
2.4. RaCUNOVOUSIVENT PrOCES .....uuuiiiieeiiiiiiiiiiiie e e e e e e ettt s e e e e e eeeeannn s e e e e e aeeennnes 6
2.5. Knjigovodstvene isprave u raCunovodstvu trgovacke robe..............cccceeeeees 6
3. UPRAVLJANJE U RACUNOVODSTVU ....coiviiierieeieeeteceee e 7
3.1. Struktura raunovodstVa ... 7
3.2. FINaNCIJSKO UPTaVlanje ......ccoooeeeieeeeeeeeeeeeeee e 7
3.3. UpravljaCko raCunovOodStVO...........eiiiiiiiiiiiiiiiie e 8
3.4. Informacije potrebne za donosenje upravljackih odluka .....................ooeee. 8
4. PLANIRANJE U RACUNOVODSTVU ..ot 9
4.1. Stratesko planiranje i postojeéi program............ccceeeeiieeiiiiiiiiiiiii e, 9
4.2. Formalni sustav strateSkog planiranja ..........cccoo 9
4.3. RaCunovodstveno planiranje ..........coouoiiiiiiiiiii e 10

4.3.1. Svrha raCunovodstvenog planiranja..........cccccooeeei 10

4.3.2. Zadaci racunovodstvenog planiranja ...........ccccoeeeeeieiiiiiiceciicn e, 10
5. RACUNOVODSTVENO PLANIRANJE U TRGOVINI.... c.covovereereercereee 11
5.1. Pojam raCunovodstvenog plana .............ccooveeiiiiiiiiiiiiii e 11
5.2, Plan PrOU@JE ... 11

5.2.1. PogreSke u prognozi Prodaje ...........uuueeiieeeeiiiieiiiiiee e 11

5.2.2. Tehnike predvidanja prodaje ..........ccooeeeiiii, 12

5.2.3. Podloga za prognozu i izrada plana prodaje............ccccceeeveeviiiineeeeennnn. 13
5.3, Plan NADAVE.........oiii et a e 13

5.3.1. Pretpostavke za izradu plana nabave.............ccccoeeiiiiiiiiiiiieiiin e, 14

5.3.2. PogreSke u planiranju zaliha............cccooeeiii, 14
5.4. Plan troSkova marketinga i UPIaVe .........cooeeeeeieeeiiiiiiiee et eeeeeaes 15
5.5, PlaN NOVCA......uiiiiiii ettt e e s e e e e e e e e e et e e e e e e eeeeenes 15
5.6. Upravljanj@ NOVCEIM .......ccoiiiiiiiieeie et e et e e e a e e eens 15
5.7. Planski financijski izvjeStaji ... 16
5.8. Izrada raCunovodstvenog plana..........coooooii 16

5.8.1. Vremenski vijek raCunovodstvenog plana...........ccccooeveeviiiviiiiiiiineeen, 16

5.8.2. KOMISija za Planiran)@........coeeeeeiieiiiiiiiiee et 17
5.9. Uloga raCunovodstva U planiranjU ..........ccoeeeeeeeeeeeiiiiiieeeeeeeeeeiiinseeeeeseeeennns 18
5.10. Ljudski utjecaj u raCunovodstvenom planiranju ............cccceevvvvviinneeeeeeeeennns 18
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5.11. OgraniCenja Planova..........ccooooiei i 19
6. PRIMJER 1Z PRAKSE: PODUZECE ,BONUS* d.0.0. ..c.coveviiieercieeeeeeeen, 20
6.1. OpCi pOdACi O POAUZECU ......uuiiiieiiiiiiiiiiie et eeeeeeees 20
6.2. OKOIINA | KONKUIENCIJA.....cciiiiiiiiiii e 21
6.3. Odnosi s kupcima i dobavljacima ... 21
6.4. Planiranje i odIUCIVaN]E .........cooiiiiiiii e 22
6.5. RaCunovodstveno planiranje U poduzelu ..............veiiiiiiiiiiiiiiiiiiiieeeeeeeeeeies 23
7. ZAKLJUCAK ...ttt ettt ettt ettt ae e 25
8. LITERATURA L. 26
9. POPIS SLIKA 27
10. POPIS TABLIC A ..o e 28
LS = 41 @ 74 PP PPEPRPPR 29
LS IR0 O =1 = o= U 30
9.2. Racun dobiti i gUDItKA...........ccoiiiiii 31
9.2. Financijski plan za 2010. gOUINU.........cooiiiiiiiiiiiiiiiiiiee e 32
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Prilog br. 3: Literatura

5. LITERATURA

Strucne knjige:

1. Scott, M.; Cutlip Allen H.; Center Glen, M.: Odnosi s javno$¢u, Mate d.o.o.,
Zagreb, 2003.

2. Tkalac Verc€ic, A.: Odnosi s javnos¢u, Hrvatska udruga za odnose s javnoséu,
Zagreb, 2015.

3. Tomi¢, Z.: Odnosi s javnoscu teorija i praksa, Synopsis, Zagreb, 2008.

Internet stranice:

1. Odnosi s javnoscu http://library.fes.de/pdf-files/bueros/sarajevo/06282.pdf
(4.3.2017.)

2. Vaznost odnosa s javno$cu http://ivancolakovic.blogspot.hr/ (4.3.2017.)

3. web stranice Hrvatske udruge za odnose s javnos¢u http://www.huoj.hr/osj-za-

pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu (4.3.2017.)

4. Odnosi s javnoscu https://hr.wikipedia.org/wiki/Odnosi_s_javno (20.4.2017.)
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Prilog br. 4. Popis slika, tablica i grafickih prikaza

6. POPIS SLIKA

1. Slika 1.: Model komunikacijskog kanala ... 2
2. Slika 2.: Koristenje informacije i proces komunikacije u poslovnoj organizaciji ... 3

3. Slika 3.: Raspodjela bitnih i sporednih dljelova poslovnog pisma  .................... 4

7. POPIS TABLICA

1. Tablica 1.: Model komunikacijskog kanala ................coooiiiiiiiiii . 3
2. Tablica 2.: Proces komunikacije u poslovnoj organizaciji ............cccceeveiniinnn... 5
3. Tablica 3.: Raspodijela bitnih i sporednih dijelova poslovnog pisma .................. 7
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Prilog br. 5: Posljednja stranica rada

Datum predaje rada:

(mentor je prihvatio izradbu)

Potpis mentora:

Ocjena pisanog rada:

Datum obrane rada:

Ocjena obrane rada:

Konaéna ocjena:

Povjerenstvo:

1. mentor:

2. profesor struke :

3. profesor struke:

Prostor za izdvojeno misliene ili eventualni komentar:
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Prilog br. 6: Konzultacijski list

Konzultacijski list za u€enika :

Upute za izradbu zavrsnog rada

, razred:

Rberd. Datum BiljeSke o napredovanju Potpis mentora
' konzultacija
Koprivnica, $§k.god.2017./2018.




